ﬁ- adafruit learning system

Adafruit Feather 32u4 Basic Proto




Guide Contents

Guide Contents 2
Overview 4
Pinouts 8
Power Pins 9
Logic pins 9
Other Pins! 10
Assembly 11
Header Options! 11
Soldering in Plain Headers 14
Prepare the header strip: 14
Add the breakout board: 15
And Solder! 15
Soldering on Female Header 17
Tape In Place 17
Flip & Tack Solder 17
And Solder! 19
Power Management 21
Battery + USB Power 21
Power supplies 22
Measuring Battery 22
ENable pin 23
Arduino IDE Setup 24
https://adafruit.github.io/arduino-board-index/package_adafruit_index.json 25
Using with Arduino IDE 27
Install Drivers (Windows Only) 28
Blink 29
Manually bootloading 30
Ubuntu & Linux Issue Fix 31
Downloads 32
Schematic 32
Fabrication Print 32
Feather HELP! 34
My Feather stopped working when | unplugged the USB! 34
My Feather never shows up as a COM or Serial port in the Arduino IDE 34
Ack! | "did something" and now when | plug in the Feather, it doesn't show up as a device anymore so | cant
upload to it or fix it... 34
| can't get the Feather USB device to show up - | get "USB Device Malfunctioning" errors! 35
I'm having problems with COM ports and my Feather 32u4/MO0 35
| don't understand why the COM port disappears, this does not happen on my Arduino UNO! 36
I'm trying to upload to my 32u4, getting "avrdude: butterfly_recv(): programmer is not responding" errors 36
I'm trying to upload to my Feather MO, and | get this error "Connecting to programmer: .avrdude: butterfly_recv():
programmer is not responding” 36
I'm trying to upload to my Feather and i get this error "avrdude: ser_recv(): programmer is not responding" 36
© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-basic-proto Page 2 of 36



| attached some wings to my Feather and now | can't read the battery voltage!
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Overview

Feather is the new development board from Adafruit, and like it's namesake it is thin, light, and lets you fly! We
designed Feather to be a new standard for portable microcontroller cores.
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At the Feather 32ué's heart is at ATmega32u4 clocked at 8 MHz and at 3.3V logic, a chip setup we've had tons of
experience with as it's the same as the Flora. This chip has 32K of flash and 2K of RAM, with built in USB so not only

does it have a USB-to-Serial program & debug capability built in with no need for an FTDI-like chip, it can also act like a
mouse, keyboard, USB MIDI device, etc.
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To make it easy to use for portable projects, we added a connector for any of our 3.7V Lithium polymer batteries and
built in battery charging. You don't need a battery, it will run just fine straight from the micro USB connector. But, if you
do have a battery, you can take it on the go, then plug in the USB to recharge. The Feather will automatically switch
over to USB power when its available. We also tied the battery thru a divider to an analog pin, so you can measure and
monitor the battery voltage to detect when you need a recharge.
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Here's some handy specs!

Measures 2.0" x 0.9" x 0.28" (51Tmm x 23mm x 8mm) without headers soldered in
Light as a (large?) feather - 4.8 grams

ATmega32u4 @ 8MHz with 3.3V logic/power

3.3V regulator with 500mA peak current output

USB native support, comes with USB bootloader and serial port debugging
You also get tons of pins - 20 GPIO pins

Hardware Serial, hardware 12C, hardware SPI support

7 x PWM pins

10 x analog inputs

Built in 100mA lipoly charger with charging status indicator LED

Pin #13 red LED for general purpose blinking

Power/enable pin

4 mounting holes

Reset button

The Feather 32u4 Basic Proto has some extra space left over, so we give you a tiny little prototyping area. If you just
need to attach a button or sensor, you may be able to skip out on a breadboard and wire it directly on there.
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Comes fully assembled and tested, with a USB bootloader that lets you quickly use it with the Arduino IDE. We also

toss in some header so you can solder it in and plug into a solderless breadboard. Lipoly battery and USB cable not
included (but we do have lots of options in the shop if you'd like!)

Check out our tutorial for all sorts of details, including schematics, files, IDE instructions, and more!
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Pinouts
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The Feather 32u4 Basic is chock-full of microcontroller goodness. There's also a lot of pins and ports. We'll take you a
tour of them now!
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GND - this is the common ground for all power and logic

BAT - this is the positive voltage to/from the JST jack for the optional Lipoly battery

USB - this is the positive voltage to/from the micro USB jack if connected

EN - this is the 3.3V regulator's enable pin. It's pulled up, so connect to ground to disable the 3.3V regulator
3V - this is the output from the 3.3V regulator, it can supply 500mA peak

ic pins

This is the general purpose I/0O pin set for the microcontroller. All logic is 3.3V

e #0/RX - GPIO #0, also receive (input) pin for Seriall and Interrupt #2
e #1/TX-GPIO #1, also transmit (output) pin for Serial1l and Interrupt #3
e #2/SDA - GPIO #2, also the 12C (Wire) data pin. There's no pull up on this pin by default so when using with 12C,

you may need a 2.2K-10K pullup. Also Interrupt #1
#3 / SCL - GPIO #3, also the 12C (Wire) clock pin. There's no pull up on this pin by default so when using with 12C,
you may need a 2.2K-10K pullup. Can also do PWM output and act as Interrupt #0.

e #5-GPIO #5, can also do PWM output
e #6 - GPIO #6, can also do PWM output and analog input A7
e #9 - GPIO #9, also analog input A9 and can do PWM output. This analog input is connected to a voltage divider
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for the lipoly battery so be aware that this pin naturally 'sits' at around 2VDC due to the resistor divider

e #10 - GPIO #10, also analog input A10 and can do PWM output.

e #11- GPIO #11, can do PWM output.

e #12 - GPIO #12, also analog input A11

e #13 - GPIO #13, can do PWM output and is connected to thered LED next to the USB jack

e AO thru A5 - These are each analog input as well as digital I/O pins.

® SCK/MOSI/MISO - These are the hardware SPI pins, you can use them as everyday GPIO pins but recommend
keeping them free as they are best used for hardware SPI connections for high speed. Also used to reprogram
the chip with an AVR programmer if you need.

Other Pins!

® RST - this is the Reset pin, tie to ground to manually reset the AVR, as well as launch the bootloader manually

e ARef - the analog reference pin. Normally the reference voltage is the same as the chip logic voltage (3.3V) but if
you need an alternative analog reference, connect it to this pin and select the external AREF in your firmware.
Can't go higher than 3.3V!
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Assembly

We ship Feathers fully tested but without headers attached - this gives you the most flexibility on choosing how to use
and configure your Feather

Header Options!
Before you go gung-ho on soldering, there's a few options to consider!
The first option is soldering in plain male headers, this

lets you plug in the Feather into a solderless
breadboard
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Another option is to go with socket female headers. This
won't let you plug the Feather into a breadboard but it
will let you attach featherwings very easily
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We also have 'slim' versions of the female headers, that
are a little shorter and give a more compact shape
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Finally, there's the "Stacking Header" option. This one is
sort of the best-of-both-worlds. You get the ability to
plug into a solderless breadboard and plug a
featherwing on top. But its a little bulky

Soldering in Plain Headers
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Prepare the header strip:
+ SamEs snumsEw sasss sssss T Cut the strip to length if necessary. It will be easier to

e solder if you insert it into a breadboard - long pins down
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Add the breakout board:

Place the breakout board over the pins so that the short

~___ pins poke through the breakout pads
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And Solder!

Be sure to solder all pins for reliable electrical contact.

(For tips on soldering, be sure to check out our Guide to

Excellent Soldering (https://adafru.it/aTk)).
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! ~ Solder the other strip as well.
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You're done! Check your solder joints visually and
o continue onto the next steps
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Soldering on Female Header

Tape In Place
For sockets you'll want to tape them in place so when

you flip over the board they don't fall out
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Flip & Tack Solder

After flipping over, solder one or two points on each
strip, to 'tack' the header in place
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And Solder!

Be sure to solder all pins for reliable electrical contact.

(For tips on soldering, be sure to check out our Guide to
Excellent Soldering (https://adafru.it/aTk)).
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You're done! Check your solder joints visually and
continue onto the next steps

Featper 1@, WiFi e.ﬂ

CATHINC 15880 # |
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Power Management

Battery + USB Power

We wanted to make the Feather easy to power both when connected to a computer as well as via battery. There's two
ways to power a Feather. You can connect with a MicroUSB cable (just plug into the jack) and the Feather will regulate
the 5V USB down to 3.3V. You can also connect a 4.2/3.7V Lithium Polymer (Lipo/Lipoly) or Lithium lon (Lilon) battery
to the JST jack. This will let the Feather run on a rechargable battery. When the USB power is powered, it will
automatically switch over to USB for power, as well as start charging the battery (if attached) at 100mA. This
happens 'hotswap' style so you can always keep the Lipoly connected as a 'backup' power that will only get used
when USB power is lost.
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The above shows the Micro USB jack (left), Lipoly JST jack (top left), as well as the 3.3V regulator and changeover
diode (just to the right of the JST jack) and the Lipoly charging circuitry (to the right of the Reset button). There's also a
CHG LED, which will light up while the battery is charging. This LED might also flicker if the battery is not connected.

Power supplies

You have a lot of power supply options here! We bring out the BAT pin, which is tied to the lipoly JST connector, as
well as USB which is the +5V from USB if connected. We also have the 3V pin which has the output from the 3.3V
regulator. We use a 500mA peak AP2112K-3.3. While you can get 500mA from it, you can't do it continuously from 5V
as it will overheat the regulator. It's fine for, say, powering an ESP8266 WiFi chip or XBee radio though, since the

current draw is 'spiky' & sporadic.
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Measuring Battery

If you're running off of a battery, chances are you wanna know what the voltage is at! That way you can tell when the
battery needs recharging. Lipoly batteries are 'maxed out' at 4.2V and stick around 3.7V for much of the battery life,
then slowly sink down to 3.2V or so before the protection circuitry cuts it off. By measuring the voltage you can quickly
tell when you're heading below 3.7V

To make this easy we stuck a double-100K resistor divider on the BAT pin, and connected it to D9 (a.k.a analog #9
A9). You can read this pin's voltage, then double it, to get the battery voltage.
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#define VBATPIN A9

float measuredvbat = analogRead(VBATPIN);

measuredvbat *= 2; // we divided by 2, so multiply back
measuredvbat *= 3.3; // Multiply by 3.3V, our reference voltage
measuredvbat /= 1024; // convert to voltage

Serial.print("VBat: " ); Serial.println(measuredvbat);

This voltage will 'float' at 4.2V when no battery is plugged in, due to the lipoly charger output, so its not a good way to
detect if a battery is plugged in or not (there is no simple way to detect if a battery is plugged in)

OOOOOOO@@ZJ
"13 g rs-SC-l-SUﬁ _j'

00000000

nOOOOOOOO
w99 222200

FERREETRRE"

-

RX- TXGND |

28
0 0000

ENable pin

If you'd like to turn off the 3.3V regulator, you can do that with the EN(able) pin. Simply tie this pin to Ground and it will
disable the 3V regulator. The BAT and USB pins will still be powered
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Arduino IDE Setup

The first thing you will need to do is to download the latest release of the Arduino IDE. You will need to be using
version 1.8 or higher for this guide

Arduino IDE Download
https://adafru.it/f1P

After you have downloaded and installed the latest version of Arduino IDE, you will need to start the IDE and navigate
to the Preferences menu. You can access it from the File menu in Windows or Linux, or the Arduino menu on OS X

- \
& Blink | Arduino 1.8.2 =

Edit Sketch Tools Help
Mew Ctrl+M
Open... Ctrl+Q
Open Recent L
Sketchbook J [l
Exarnples
Cloze Chrl+W
| Save Ctrl+5
Save As.., Ctrl+5Shift+5
1 Page Setup  Cirl+Shift+P
| Print Ctrl+P
I Preferences  Ctrl+ Comma - Blic domain
Quit Ctrl+Q

A dialog will pop up just like the one shown below.
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& Preferences

Sketchbook location:

fUsers [todd/Documents fArduino Browse
Editor language: = System Default +  (requires restart of Arduino)
Editor font size: 10 (requires restart of Arduinag)
Show verbose output during: compilation upload
Compiler warnings: None B

Display line numbers
v Verify code after upload
Use external editor
v Check for updates on startup
v/ Update sketch files to new extension on save (.pde -> .ino)

v Save when verifying or uploading
Proxy Settings

Server (HTTP): Port (HTTP): 8080
Server: (HTTPS) Port (HTTPS): 8443
Username: Password:

Additional Boards Manager URLs: |

Maore preferences can be edited directly in the file
{Users /todd/Library/Arduinol5/preferences.txt
(edit only when Arduino is not running)

OK Cancel

We will be adding a URL to the new Additional Boards Manager URLs option. The list of URLs is comma separated,
and you will only have to add each URL once. New Adafruit boards and updates to existing boards will automatically
be picked up by the Board Manager each time it is opened. The URLs point to index files that the Board Manager uses
to build the list of available & installed boards.

To find the most up to date list of URLs you can add, you can visit the list of third party board URLs on the Arduino IDE
wiki. We will only need to add one URL to the IDE in this example, but you can add multiple URLS by separating them

with commas. Copy and paste the link below into the Additional Boards Manager URLs option in the Arduino IDE
preferences.

https://adafruit.github.io/arduino-board-index/package_adafruit_index.json
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C:\UsersYadyada\Dropbox \ArduinaSketches

Editor language: [System Default = (requires restart of Arduinc)

Editor font size: [z ]

Interface scale: V] Automatic | 100 <% (requires restart of Arduino)

Show verbose output during: V] compilation [/ upload |
Compler warmings: [None  + "
|| Cisplay bne numbers 1l
7] Enable Cade Folding

[] Verify code after upload {
7] Use external editor

[¥] Check for updates on startup

[¥] Update sketch files to new extension on save (.pde -> .ina)

[¥] Sawe when verifying or uplog

dioa

Additional Boards Manager URLs:fl https: f/adafruit. com fpackage _adafruit_index.json :
More preferences can be edited arecty n Die e Enter a comma separated list of urls

C:\UsersVadyada\AppDatal ocal\rduino 15\preferences. bt I\
(edit onky when Arduino is not running) \

Here's a short description of each of the Adafruit supplied packages that will be available in the Board Manager when
you add the URL:

e Adafruit AVR Boards - Includes support for Flora, Gemma, Feather 32u4, Trinket, & Trinket Pro.

e Adafruit SAMD Boards - Includes support for Feather MO, Metro MO, Circuit Playground Express, Gemma MO
and Trinket MO

e Arduino Leonardo & Micro MIDI-USB - This adds MIDI over USB support for the Flora, Feather 32u4, Micro and
Leonardo using the arcore project.

If you have multiple boards you want to support, say ESP8266 and Adafruit, have both URLs in the text box separated
by a comma (,)

Once done click OK to save the new preference settings. Next we will look at installing boards with the Board
Manager.

Now continue to the next step to actually install the board support package!
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Using with Arduino IDE

Since the Feather 32u4 uses an ATmega32u4 chip running at 8 MHz, you can pretty easily get it working with the
Arduino IDE. Many libraries (including the popular ones like NeoPixels and display) work great with the '32u4 and 8
MHz clock speed.

Now that you have added the appropriate URLs to the Arduino IDE preferences, you can open the Boards Manager by
navigating to the Tools->Board menu.

é Blink | Arduino LE.4

File Edit Sketch Help

Auto Format Cirl+T
Archive Sketch

Fix Encoding & Reload

Serial Maonitor Ctrl+Shift+M
Serial Plotter Ctrl+Shifit+L

WiFil01 Firmware Updater

Board: "Arduino Pro or Pro Mini” '
Processor: "ATmega328P (3.3V, 8 MHz)" !

Boards Manager...
/f PFin 13 has T =7
TSN Dart- "Nk GR" ' -

Once the Board Manager opens, click on the category drop down menu on the top left hand side of the window and
select Contributed. You will then be able to select and install the boards supplied by the URLs added to the
prefrences. In the example below, we are installing support for Adafruit AVR Boards, but the same applies to all
boards installed with the Board Manager.

Type | All L] *| | Fiilter your search

Arduino AVR Boards Buit-in by Arduino version 1.6.F INSTALLED

Boards incuded in this package:

Arduing dn, Arduing Ung, Ardulne Diecimila, Ardulng Nand, Ardulng Mega, Arduine MegaADK, Arduing Leonardo, Anduing Micre, Ardulne Esplara,
Arduine Mini, Arduine Ethernet, Arduine Fie, Arduine BT, Arduing LilyPadUSE, Arduine Lilypad, Arduine Pre, Arduing ATMegaNG, Arduing Robet
Control, Arduing Robot Mator, Arduing Gemma.

Online hely

Mare info

Arduine SAM Boards (32-bits ARM Cortex-M3) by Arduine
Boards incdused in this package:

Arguing Dise,

Online help

Hare info

Intel 586 Boards by Intel
Baards Inchuded in this package:
Galileo.

More info

Next, quit and reopen the Arduino IDE to ensure that all of the boards are properly installed. You should now be able
to select and upload to the new boards listed in the Tools->Board menu.
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r

Blink | Arduino 1.6.5

—

File Edit Sketch [Tools| Help

Y
Arduino Ethernet

Arduino Fio

Arduino BT

LilyPad Arduine USE
LilyPad Arduine
Arduino Pro er Pro Mini
Arduino NG or older
Arduino Rebet Control
Arduino Rebot Motor

Arduino Gemma

Arduino ARM (32-bits) Boards
Arduino Due (Programming Port)
Arduino Due (Mative USE Port)

Auto Format Ctrl+T
Archive Sketch
Fix Encoding & Reload

1= Serial Monitor Ctrl+Shift+M

2 Blink

3| Turns on Board: "Arduino/Genuino Una"

N Port

5 Most Ard

6| Leonardg Prograrmmer: "USBtinyISP"
7 pin the
s the docy Burn Bootloader
9

10 This example code is in the public domain.

11

12 modified & May 2014

13 by Scott Fitzgerald

14 =/

15

16

17 // the setup function runs once when you press resg

18 wvoid setup() {

19 S/ initialize digital pin 13 as an output.

20 pinMode {13, CUTFUT):

21}

22

23 // the loop function runs over and over again forey

Install Drivers (Windows Only)

Adafruit Boards
Adafruit Flora

Adafruit Bluefruit Micro
Adafruit Gemma 8MHz
Adafruit Feather 32ud

When you plug in the Feather, you'll need to possibly install a driver

Click below to download our Driver Installer

Download and run the installer

Download Adafruit Drivers Installer

https://adafru.it/AON

-

Opening adafruit_drivers.exe

==

You have chosen to open:
[n"] adafruit_drivers.exe

which is: Binary File (13.6 MB)

from: https://github-cloud.s3.amazonaws.com

Would you like to save this file?

[ e ] | Cancel |

Run the installer! Since we bundle the SiLabs and FTDI drivers as well, you'll need to click through the license
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https://github.com/adafruit/Adafruit_Windows_Drivers/releases/latest/adafruit_drivers_*.exe

-
* Adafruit Board Drf\rers:.License Agreement = | —

Please review the license agreement before installing Adafruit board
drivers. If you accept all terms of the agreement, dick I Agree.

hhis program will allow you to install Windows drivers for -
hardware that Adafruit Industries produces. Please support
Adafruit by purchasing hardware from:
<http://www.adafruit.com/>

I
Mote you can uninstall any of the installed drivers by using I
the Add/Remove Programs option in Control Panel (look for
the "Windows Driver Package' entries from Adafruit).
- | |

| |
Cancel | Mullsoft Install System w3, 0b3 I Agree

Select which drivers you want to install:

Check the board drivers below that you would like to install. Click install to
start the installation.

Select board drivers to install: Feather 32u4, Feather MO, Feather MO Es
Feather WICED
Trinket / Pro Trinket [ Gemma (LISBtinyISP)

[ Arduine Gemma
] Feather HUZZAH ESP8266 (SiLabs CP210x)
[ Metro 323  Metra Mini 323 (FTDI VCP and

3

Cancel | Mullsaft Install System w302, 1 < Back | Install I

Click Install to do the installin'

-
¥ Adafruit Board Drivers: Completed *Lﬂiﬂﬂ

Completed

Show details |

Cancel | Mullsoft Install System v3.0b3 <= Back

Blink

Now you can upload your first blink sketch!

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-basic-proto Page 30 of 36



Plug in the Feather 32u4 and wait for it to be recognized by the OS (just takes a few seconds). It will create a
serial/COM port, you can now select it from the dropdown, it'll even be 'indicated' as Feather 32u4!

L w
Blink | Arduino 16.5 —— —
"
File Edit Sketch [Tools] Help

Auto Format Ctrl+T
Archive Sketch
Fix Enceding & Reload
1/ Serial Monitor Ctrl+Shift+M
2 Blink
3| Turns on Board: "Adafruit Feather 32ud" ¥pe second, repeatedly.
: Port Serial ports
5 Most Ard
¢ Leonarda i COML (Adafruit Feather 32ud)
- Sl Programmer: "USBtinyISP"
7| pin the Comiz2
- he do Burn Bootloader .
I & the doc COM105 (Adafruit Feather 32ud)
9

Now load up the Blink example

// the setup function runs once when you press reset or power the board
void setup() {

// initialize digital pin 13 as an output.

pinMode(13, OUTPUT);
}

// the loop function runs over and over again forever
void loop() {
digitalWrite(13, HIGH); // turn the LED on (HIGH is the voltage level)

delay(1000); // wait for a second
digitalWrite(13, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

}

And click upload! That's it, you will be able to see the LED blink rate change as you adapt the delay() calls.
Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and doesn't auto-reboot
into the bootloader, double-click the RST button to get back into the bootloader. The red LED will pulse, so you know
that its in bootloader mode. Do the reset button double-press right as the Arduino IDE says its attempting to upload the
sketch, when you see the Yellow Arrow lit and the Uploading... text in the status bar.
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atcommand | Arduine 1.6.4 E@&J

atcommand BluefruitCanfig.h

space. Maximum is

Adafruit Bluefruit Micro on COMEGE

Don't click the reset button before uploading, unlike other bootloaders you want this one to run at the time Arduino is
trying to upload

Ubuntu & Linux Issue Fix

Note if you're using Ubuntu 15.04 (or perhaps other more recent Linux distributions) there is an issue with the modem
manager service which causes the ATmega32u4 micro to be difficult to program. If you run into errors like "device or
resource busy", "bad file descriptor", or "port is busy" when attempting to program then you are hitting this issue.

The fix for this issue is to make sure Adafruit's custom udev rules are applied to your system. One of these rules is

made to configure modem manager not to touch the board and will fix the programming difficulty issue. Follow the
steps for installing Adafruit's udev rules on this page.
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https://bugs.launchpad.net/ubuntu/+source/modemmanager/+bug/1473246
file:///adafruit-arduino-ide-setup/linux-setup#udev-rules

Downloads

® F[ritzing object in the Adafruit Fritzing Library

® EagleCAD PCB files in GitHub

Pinout diagram of Feather 32u4 Basic

https://adafru.it/z3b
Schematic
Click to enlarge
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Fabrication Print

Dimensions in inches
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https://github.com/adafruit/Adafruit-Feather-32u4-Basic-Proto-PCB
https://cdn-learn.adafruit.com/assets/assets/000/046/192/original/Adafruit_Feather_32u4_Basic_Proto_v2.3.pdf?1504803865
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Feather HELP!

My Feather stopped working when | unplugged the USB!

A lot of our example sketches have a

while (!Serial);

line in setup(), to keep the board waiting until the USB is opened. This makes it a lot easier to debug a program
because you get to see all the USB data output. If you want to run your Feather without USB connectivity, delete or
comment out that line

My Feather never shows up as a COM or Serial port in the Arduino IDE

A vast number of Feather 'failures' are due to charge-only USB cables

We get upwards of 5 complaints a day that turn out to be due to charge-only cables!

Use only a cable that you know is for data syncing

If you have any charge-only cables, cut them in half throw them out. We are serious! They tend to be low quality in
general, and will only confuse you and others later, just get a good data+charge USB cable

Ack! | "did something" and now when I plug in the Feather, it doesn't show up as a device anymore so | cant upload
to it or fix it...

No problem! You can 'repair' a bad code upload easily. Note that this can happen if you set a watchdog timer or
sleep mode that stops USB, or any sketch that 'crashes' your Feather

1.
2
3.
4

o o

Turn on verbose upload in the Arduino IDE preferences

. Plug in feather 32u4/MO, it won't show up as a COM/serial port that's ok

Open up the Blink example (Examples->Basics->Blink)

. Select the correct board in the Tools menu, e.g. Feather 32u4 or Feather MO (check your board to make sure

you have the right one selected!)

Compile it (make sure that works)

Click Upload to attempt to upload the code

The IDE will print out a bunch of COM Ports as it tries to upload. During this time, double-click the reset
button, you'll see the red pulsing LED that tells you its now in bootloading mode

The Feather will show up as the Bootloader COM/Serial port

The IDE should see the bootloader COM/Serial port and upload properly
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&5 Blink | Arduino 165 = B S|

| File Edit Sketch Tools Help

Arduing Leonarde on COMIZ

| can't get the Feather USB device to show up - | get "USB Device Malfunctioning" errors!
This seems to happen when people select the wrong board from the Arduino Boards menu.

If you have a Feather 32u4 (look on the board to read what it is you have) Make sure you select Feather 32u4 for
ATMega32u4 based boards! Do not use anything else, do not use the 32u4 breakout board line.

If you have a Feather MO (look on the board to read what it is you have) Make sure you select Feather MO - do not
use 32u4 or Arduino Zero

I'm having problems with COM ports and my Feather 32u4/MO
Theres two COM ports you can have with the 32u4/MO, one is the user port and one is the bootloader port. They
are not the same COM port number!

When you upload a new user program it will come up with a user com port, particularly if you use Serial in your user
program.

If you crash your user program, or have a program that halts or otherwise fails, the user com port can disappear.
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When the user COM port disappears, Arduino will not be able to automatically start the bootloader and upload
new software.

So you will need to help it by performing the click-during upload procedure to re-start the bootloader, and upload
something that is known working like "Blink"

| don't understand why the COM port disappears, this does not happen on my Arduino UNO!
UNO-type Arduinos have a seperate serial port chip (aka "FTDI chip" or "Prolific PL2303" etc etc) which handles all
serial port capability seperately than the main chip. This way if the main chip fails, you can always use the COM port.

MO and 32u4-based Arduinos do not have a seperate chip, instead the main processor performs this task for you. It
allows for a lower cost, higher power setup...but requires a little more effort since you will need to 'kick' into the
bootloader manually once in a while

I'm trying to upload to my 32u4, getting "avrdude: butterfly_recv(): programmer is not responding" errors

This is likely because the bootloader is not kicking in and you are accidentally trying to upload to the wrong COM
port

The best solution is what is detailed above: manually upload Blink or a similar working sketch by hand by manually
launching the bootloader

I'm trying to upload to my Feather MO, and | get this error "Connecting to programmer: .avrdude: butterfly_recv():
programmer is not responding"

You probably don't have Feather MO selected in the boards drop-down. Make sure you selected Feather MO.

I'm trying to upload to my Feather and i get this error "avrdude: ser_recv(): programmer is not responding"

You probably don't have Feather MO / Feather 32u4 selected in the boards drop-down. Make sure you selected
Feather MO (or Feather 32u4).

| attached some wings to my Feather and now | can't read the battery voltage!
Make sure your Wing doesn't use pin #9 which is the analog sense for the lipo battery!
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